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Bruker software support is available via phone, fax, e-mail, Internet, or ISDN.
Please contact your local office, or directly:

Address: Bruker Analytik GmbH
Software Department
Rudolf-Plank-Str. 23, D-76275 Ettlingen, Germany
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Please make use of the report form at the end of the manual for comments, error 
reports, and suggestions.
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Chapter 1

Introduction

1.1 What is NMR-CHECK?

NMR-CHECK is an easy-to-use interface which offers features to test the basic func-
tionality of Bruker NMR spectrometers. The major hardware components of
Avance Spectrometers can be checked with just a few mouse clicks. This can be
done either on-site, i.e., tests are started directly by the operator, or remotely by
Bruker service personnel connected to the instrument over networks.

In addition to the check of individual components, a test of the entire spectrometer
is available via Internet or ISDN. After establishing such a network connection,
Bruker specialists can easily work at the operating systems level of the UNIX
workstation. Hence, the spectrometer operator does not have to type in compli-
cated UNIX commands that were told to him over the phone.

When a high-speed communication line is available, preferably via ISDN, NMR-
CHECK offers a remote control function. This means that the entire spectrometer
can be simultaneously driven by the local operator and a distant Bruker partner
somewhere in the world. During this session both conferees use the same, well-
known XWIN-NMR interface.
3
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1.2 Hardware/software requirements

Computer and Operating System: 

Silicon Graphics (SGI): CPU R4000, R4400, R4600, R5000. Operating System
IRIX 5.3, 6.2, 6.3, or 6.5.

Spectrometer: Avance or ARX/AMX2/ASX (for hardware tests only useful when
equipped with HPPR or BSMS)

Software:

XWIN-NMR 1.3 or newer must have been installed prior to NMR-CHECK 2.1.

Release Medium:

NMR-CHECK 2.1 is delivered on the NMR-Suite CD containing XWIN-NMR 2.6.

Network access (optional but strongly recommended):

Internet: Local routing of Bruker’s IP addresses (class B: 149.236.) from the 
workstation to the Internet via a gateway must be accomplished. The cla
subnet 149.236.99, however, must be routed to the console computer CC
the second Ethernet port as usual.

ISDN: Basic rate interface (two B channels) S0, D-channel protocol E-DSS1 (Euro
ISDN) or 1TR6 (occasionally used in Germany) required. All services (t
phony, fax, data transmission) have to be activated.
In addition, an ISDN telephone can be connected to the S0 bus. When used,
however, the maximum rate of data transfer is limited to 64 kbit/s (one B c
nel). You should avoid connecting any additional ISDN device.
ISDN cable: RJ-45 to RJ-45, pins 3 to 6 directly connected, up to 150 m lon
measured from the Network Termination NT. Shielded (STP) or unshie
(UTP) twisted-pair cables can be used as well. Part numbers: 83024 (
83025 (5 m), 83026 (10 m).
Indirect ISDN access via an ISDN gateway is possible. Such a gateway 
use the Password Authentication Protocol PAP. A permanent PAP access
and PAP password have to be allocated. Dynamic assignment of IP addres
permitted.

SGI Indy workstations come with an ISDN controller built-in. O2 workstatio
require an external device, which must be connected to serial port #1. The fol-
lowing devices are currently supported:
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– Elsa MicroLink ISDN/TL pro (ISDN terminal adapter; only for O2 workst
tions; Bruker part number: O001164)

– Elsa MicroLink ISDN/TL V.34 (ISDN terminal adapter/modem combinatio
must be connected to an S0 interface; primarily for Bruker Service Centers
ISDN functionality only available on O2 workstations; Bruker part numb
O001163)

Telephone network: Conventional analog telephone interface. Supported exte
devices:
– Elsa MicroLink 33.6TQV / 56k (high-speed modems; can be used with I

and O2 workstations; Bruker part number: O001162)

– U.S. Robotics 33.6 or 56K modems (can be used with Indy and O2 wor
tions)

1.3 Network security

NMR-CHECK is primarily designed to operate with computer networks, thoug
can also be used on isolated spectrometer workstations. To assure highest n
security, the SGI computer should be connected to an ISDN interface. The
prominent security features implemented in NMR-CHECK include:

• NMR-CHECK can be launched by authorized personnel only. The passwor
the NMR superuser has to be entered. This password can be freely define
the system administrator.

• NMR-CHECK prints a detailed warning if there is any account in the system 
is not protected by a password (user account) or not locked (special accou

• NMR-CHECK supports shadow passwords.

• NMR-CHECK supports the Network Information Service (NIS).

• Remote access by Bruker is performed via a temporary service account. This
account is automatically created when NMR-CHECK is started up. Its password
and permissions have to be defined at the same time by the operator. Th
vice account is automatically removed from the system when NMR-CHECK is
terminated. This means that not even Bruker has access to the instrumen
NMR-CHECK is not running.

• ISDN/modem access is a two-step process. Before logging into the syste
the background via the service account, the ISDN call has to be establi
This task is controlled by the Password Authentication Protocol (PAP). The
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necessary account for this purpose has to be created with NMR-CHECK and is
not usable for any other system access.

• NMR-CHECK automatically logs the date, time, duration, and identification
any incoming and outgoing ISDN/modem call. Failures are also registered

1.4 Version

This manual applies to NMR-CHECK version 2.1. NMR-CHECK contains this manual
as on-line documentation accessible from the Help menu.

New feature added in release 2.1:

• Support of the modem 'Elsa MicroLink 56k'. –

The very successful 'Elsa MicroLink 33.6TQV' is getting out of stock. The s
cessor model 'MicroLink 56k' complies with NMR-CHECK'S specifications and
is therefore recognized by NMR-CHECK version 2.1.

Note that 56K modems require a special digital device at the other end o
connection in order to provide faster data transfer (downstream) than 3
models. Don't expect to get any advantage over 33.6K modems during re
sessions with Bruker, because the major data flow is upstream, i.e., from
spectrometer workstation to Bruker's support computer during XWIN-NMR shar-
ing.

If you want to know more about the 56K modem technology, visit the follo
ing Web sites:

www.k56flex.com (read the K56flex FAQ)
www.3com.com (search for a white paper about the V.90 technology)

1.5 Support

Software support for NMR-CHECK is available from your local Bruker office or via
e-mail from the following address:

Michael.Hansen@bruker.de

The Bruker FTP servers ftp.bruker.de and ftp.bruker.com provide additional infor-
mation such as known bugs and their workarounds in the directories 

/pub/nmr/NMRCHECK/ and /pub/nmr/mirror.bruker.de/NMRCHECK resp.

http://www.3com.com
http://www.k56flex.com
mailto:Michael.Hansen@bruker.de
ftp://ftp.bruker.de/pub/nmr/NMRCHECK
ftp://ftp.bruker.com/pub/nmr/mirror.bruker.de/NMRCHECK
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1.6 Installation of NMR-CHECK

NMR-CHECK can be separately selected as an installation item from the NMR-Suite
installation dialog window SWIM. NMR-CHECK 2.1 can only work if XWIN-NMR

1.3 or newer as well as the ISDN Execution Environment (isdn_eoe), the Point-to-
Point Protocol Software (eoe2.sw.ppp @ IRIX 5.3, eoe.sw.ppp @ IRIX 6.x), and
the UUCP Utilities (eoe2.sw.uucp @ IRIX 5.3, eoe.sw.uucp @ IRIX 6.x) have
been installed prior to NMR-CHECK. When using ISDN under IRIX 5.3, the instal-
lation of patches 363 and 531 is strongly recommended. Those patches are avail-
able from /CDROM/unix/patches5.3/.

1.7 Starting up NMR-CHECK

1.7.1 Operator restriction

NMR-CHECK can be started by anyone who has a login account on the SGI work-
station. Click on Find/Applications inside the SGI Toolchest, and double click on
NMR-CHECK’s icon, which is shown in Figure 1.1. If the main window of NMR-
CHECK does not pop up, open a console window by clicking on System/Utilities/
Start New Console (IRIX 6.3) or System/Start New Console (IRIX 6.2, 5.3), and
try again. Alternatively you can start NMR-CHECK by typing

nmrcheck

from a UNIX shell, no matter what directory you are in. You will be prompted
enter the NMR superuser password (cf. section 1.3). Ask your system administ
tor if you do not know this password.

Figure 1.1 NMR-CHECK’s desktop icon
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1.7.2 Create a temporary service account

After the NMR superuser password has been typed in, a menu as shown in Figure
1.2 pops up.

Type in a password of your choice with at least four alphanumeric characters.
Characters in excess of eight are redundant as usual. Permission: full means that
the service account will be equivalent to the root account. Thus, the entire file sys-
tem can be inspected and corrected during an on-line session. Permission:
restricted creates a service account which has the limited rights of a regular user.
The service account is used for NMR-CHECK’s diagnosis and UNIX support fea
tures. No password of any existing account has to be revealed, and no
account has to be created by the system administrator in order to enable r
access. Clicking on OK causes the automatic generation of the service acco
NMR-CHECK is now ready to use.

Keep in mind that the service account will be automatically removed from the
tem when NMR-CHECK is terminated (cf. section 1.3). If the account already ex
at start-up time for some reason, you have to confirm the password update.

Figure 1.2 Definition of temporary service access



1.8 Using the mouse or the keyboard 9

either

with

r-

ton

 left

per-
 and

s take
ate
DONE

INDEX

INDEX

1.8 Using the mouse or the keyboard

Within NMR-CHECK, you can use the mouse or the keyboard to select items and
execute commands, and to position the text cursor.

• In order to execute a function represented by a button or a menu item, 
click on it using the left mouse button, or hit the Enter key once it is selected.

• In order to select the next or previous button in a window for execution 
Enter, use the Tab or Shift +Tab keys.

• In order to select the next or previous menu item or list box item, use the Down
Arrow or Up Arrow keys, or the left mouse button.

• In order to move the text cursor within text entry fields, use the Left Arrow or
Right Arrow keys, or the left mouse button.

• Hitting the Enter key while editing a text field executes the Save function.

• In order to close a window, click on the right-most button (Cancel or Quit) or
press the Esc key. The click-away function (double-click on the upper left co
ner of the window) is available only for login windows.

• The passwords for ISDN access (Setup/Hosts Configuration/Modify/ISDN/
Password:) and on-line service (Setup/Hosts Configuration/Modify/Service/
Password:) can be made visible by double-clicking with the left mouse but
inside the entry field, or by selecting the field and pressing the Print Screen
key.

• Computer names in list boxes can be chosen by double-clicking with the
mouse button.

• In addition to moving the scroll bar, browsing through list boxes can be 
formed by keeping the middle mouse button pressed inside the list box
moving the mouse appropriately. Alternatively, the Page Up/Page Down keys
can be used when the list box has been selected with the Tab key.

1.9 Appearance of the mouse cursor

Outside entry fields, the mouse cursor appears as an arrow. When NMR-CHECK is
working, the mouse cursor changes to a watch. During this time NMR-CHECK does
not accept any user interaction. Be patient! Some of the diagnosis procedure
minutes until completion. Therefore, you will be informed about the approxim
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duration of every single test. If you think that NMR-CHECK has crashed because it
does not seem to be active anymore, wait a little longer. Terminate the UNIX pro-
cesses belonging to NMR-CHECK only if you are positive that NMR-CHECK has
crashed! In such a case, try to use NMR-CHECK’s Emergency Exit, i.e., double-
click the button in the upper left corner of NMR-CHECK’s main window. If that
does not help, terminate NMR-CHECK on the UNIX level. Note: The emergenc
exit function is deactivated during e-mail processing.

Warning: If you terminate NMR-CHECK on the UNIX level while an ISDN connec
tion is open, this line might remain open (producing telephone charges)! In s
case, start NMR-CHECK again and stop it orderly with the Exit function.

1.10 Tear-off menus

All menus except File and View can be torn off by clicking on the dashed line 
the top of the menu. You can move a tear-off menu to a place on the screen 
it is always accessible. It will even stay open when NMR-CHECK’s main window is
being iconified. This feature is especially useful for the Multidisplay and Diagno-
sis menus.
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Getting started

2.1 General

This chapter is a compact guide to NMR-CHECK. For details, please refer to the full
description of each function.

2.2 How to set up NMR-CHECK after installation

Fill out the form Setup/General Profile. Put in your data on the left-hand side and
those of your contact at the Bruker service department on the right. Skip the rest of
this section if you want to get on-line service via Internet, or if you just like to run
diagnosis procedures yourself. 

If your spectrometer workstation can be reached via ISDN/modem do the fol-
lowing:

• If you want to get on-line service from Germany and you are using an 
workstation, fill in 7219511060 as Bruker’s ISDN number in the Setup/General
Profile form. If your service center is in Switzerland enter 18065820. Ask
alternative numbers if you operate an O2 computer. These numbers mu
preceded by the code for long-distance calls to or in Germany and Switzer
respectively. Don’t forget any leading digit(s) required by the local teleph
11
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network to make external calls. The Bruker ISDN lines are used for computer
connections only. Don’t dial these numbers with a telephone – no human b
will answer.

• Execute Setup/Hosts Configuration/Add, enter “service” for example, fill in the
same ISDN number as before, set IPAddress to “149.236.12.10” (Germany) or
“150.205.48.51” (Switzerland), ask your Bruker contact for an Access Name
and a Password, choose Speed: High, and set Sleep if idle? to No. You don’t
have to fill out the Service page.

• If you want to share XWIN-NMR with your Bruker contact, this person will nor
mally do on-line service from his own computer, named “mike”, for exam
Therefore, you have to add host “mike” to the list of Remote Computers. 
can leave the ISDN/modem parameters empty. Switch to the Service page, ask
the Bruker person for “mike”’s IP address, set Connect via to ISDN Card
(Indy)/ISDN/TL... (O2), and set ISDN Host to “service”. Leave the Password
field blank (you don’t need a service password for XWIN-NMR sharing).

• Give Bruker the ability to call you. Execute Setup/ISDN Access Restriction and
add “bruker”, for example. Fill in a password of your choice, enter an optio
annotation (“Bruker ISDN account”, for example), and click on Save. Now,
“bruker” should show up in the restriction list. Inform your Bruker conta
about this ISDN account name and password by phone, fax or e-mail.

• Plug in the ISDN cable and execute Setup/PPP Daemon. If the PPP daemon is
running, the Start button is deactivated and the active device and protocol ty
are shown. Click on Restart. If the daemon is not running, choose the corre
protocol type (ask your ISDN provider) and click on Start.

• Now, you are hooked up for ISDN on-line service.

• Perform the same tasks if your computer is connected to an ordinary telep
interface via a high-speed modem. Choose the appropriate value from
device list and ignore the Speed and Sleep settings. The Bruker ISDN number
can be used for modem links as well.

2.3 How to get on-line service

• If you can be reached via Internet, make sure the network parameters o
spectrometer workstation are properly configured (ask your network adm
trator).

• Stop any acquisition.
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• Call your Bruker contact, start NMR-CHECK, type in the NMR superuser pass
word (ask your system administrator), enter a Service Password of your ch
and tell the Bruker person that password.

• Open the Setup/General Profile form and read the IP address of your works
tion (lower left corner). Fill in the Service Contract Number.

• If you can be reached via ISDN and it is the first time you use on-line ser
tell your Bruker partner your ISDN number, the ISDN Access Name and
ISDN Password. Make sure the PPP daemon is running.

• If you have to open the ISDN line to Bruker, terminate XWIN-NMR. Open a
sharing session to host “mike” (see previous section) with Multidisplay/Share
XWIN-NMR. Iconify the sharing window as long as you don’t perform XWIN-
NMR sharing. Your Bruker partner will then use the ISDN line to open a sp
trometer connection.

• Explain your problem and lean back. You won’t see any result of a 
sequence that has been started by remote service on your screen. Never
on-line service can only be performed as long as NMR-Check is runnin
your spectrometer.

• Terminate NMR-CHECK with File/Exit when the on-line session is over.

2.4 How to run diagnosis procedures yourself

• Double click on Connect/Spectrometer/Local instrument. Choose the compo-
nent you want to test from the Diagnosis menu. Mark the test(s) to be pe
formed and click on Start. The Expert page provides more advanced tests. T
Launch Tool button is designed for Bruker service engineers – don’t perfo
any action with this interface unless you know exactly what you are doing.

• All diagnosis output is automatically logged and accessible over a perio
eight days via View/Test Results and View/Tools Log.

• If an on-line service of your spectrometer is impossible for technical reas
you can send the diagnosis results to your Bruker contact by e-mail or fax
choose the appropriate day via File/Test Results/Send by Email or File/Test
Results/Print as Fax. The default e-mail address can be defined in Setup/
General Profile. Fax printers can be easily set up with cfpp in XWIN-NMR.
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Chapter 3

The File Menu

3.1 General

The File menu (Figure 3.1) provides functions for sending diagnosis results to
Bruker via fax or e-mail. This main menu also lets you terminate NMR-CHECK.

3.2 Test Results/Tools Log

For an explanation of the difference between Test Results and Tools Log see “Test
Results/Tools Log” on page 50.

Figure 3.1 File’s main menu and first submenu
15
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3.2.1 Print as Fax

Clicking on Print as Fax creates a submenu showing the past eight days during
which diagnosis results were obtained. Before you select a day for printing, view
its contents with View/Test Results or View/Tools Log. Then, make sure you filled
out the Setup/General Profile form (see “General Profile” on page 29). If you did
not set up any printer yet, run cfpp in XWIN-NMR first. Now, click on the desired
day. This will open an interface as shown in Figure 3.2.

Select a printer and click on Print. As a result, you will get a fax-ready printou
with cover sheet and numbered pages. Add comments by hand on the lower 
the cover sheet if you like.

3.2.2 Send by Email

Alternatively to printing and faxing diagnosis results to Bruker, you can send
same information via electronic mail. For this to work, the spectrometer work
tion needs access to the Internet, i.e., to an Internet gateway in your local ne

Figure 3.2 Interface for fax creation
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If the workstation has not yet been set up for e-mail transmission proceed as fol-
lows:

• Become superuser and edit the file /etc/sendmail.cf. After lots of comments,
there is a section called “Parameters which MUST be defined”. Replace
BAR.FOO.COM entries by the values of your local network. Ask your netw
administrator if you are not sure what to fill in.

• Run the UNIX commands

/etc/init.d/mail stop

/etc/init.d/mail start

in order to restart the sendmail daemon.

• Under IRIX 6.3 /etc/sendmail.cf is different. Leave it as it is and run /usr/etc/
configmail setup instead. Read the explanations carefully, and confirm 
restart question if you made changes. List the current settings with /usr/etc/con-
figmail list.

Preview what you are going to send by executing View/Test Results or View/
Tools Log. Click on Send by Email and then on the desired day. Confirm the que
tion whether the default e-mail address, which was defined with Setup/
General Profile, has to be used. Click on No and enter any address you like i
order to send the diagnosis results to someone else.

3.2.3 Delete Today’s

With the function Delete Today’s you can clear the lists of diagnosis results which
were obtained today. This is particularly useful when lots of results have been
recorded, but only very few are of importance to Bruker’s service personnel. 
(irreversibly) deleting the results, you have to repeat the meaningful diagnosis
cedures. Then, send the output via fax or e-mail as described above.

3.3 System Configuration

With System Configuration you can print a listing of important configuratio
parameters of the local system for fax transmission or send that compilation 
mail. You can preview the entire listing by clicking on System Configuration in the
View menu. The preceding paragraph gives details on printer and e-mail setu



18 The File Menu

-

DONE

INDEX

INDEX

3.4 XWIN-NMR Location

As of XWIN-NMR’s release 2.0, the installation directory of XWIN-NMR can be
freely defined. Furthermore, several copies of XWIN-NMR can coexist on one com
puter. Since NMR-CHECK uses test programs delivered by XWIN-NMR, it has to
know where XWIN-NMR is located. If you intend to utilize a copy of XWIN-NMR

which cannot be found via your environment variable PATH, click on XWIN-NMR

Location and select the directory containing XWIN-NMR’s binary files. This is usu-
ally the subdirectory prog/bin/ of the directory path you chose to install XWIN-NMR

in (see Figure 3.3).

If you are running NMR-CHECK in combination with XWIN-NMR 1.3, the menu item
XWIN-NMR Location is permanently deactivated, because XWIN-NMR’s installation
directory is fixed.

Figure 3.3 Declaration of XWIN-NMR’s installation directory
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3.5 Upload

After a connection to a remote spectrometer has been established with Connect/
Spectrometer, the Upload entry becomes activated. Select a single file or a direc-
tory for transmission and click on Send (see Figure 3.4). In case of a directory
selection, every file in that directory and recursively all the files in subdirectories
will be packed into an archive named upload.tar. Symbolic links will be resolved
(and must be resolvable) prior to transmission. The transmitted file or upload.tar is
stored in the directory /usr/people/service/ncup on the remote computer. You can
easily get there: click on Connect/UNIX and type cd ncup. If a directory has been
selected for transmission, move the archive upload.tar to the final destination and
unpack it (mv upload.tar <directory>; cd <directory>; tar xvf upload.tar). For
that purpose, the source files are archived with relative path names.

Press the Stop button at any time you want in order to terminate a running file
transfer. The file fragments which have been already sent, however, will remain on
the target computer. Therefore, the existence of the transferred file in the target
directory does not necessarily mean that the transmission was successful. If in
doubt, compare the file sizes of the source and target files, or verify the file identity
by comparing the checksums (sum -r <filename>).

Due to its upstream nature, the Upload function is primarily intended for Bruker
personnel. A similar download feature, which could be used by the operator whose
spectrometer is being serviced, has not been implemented for security reasons.
Please use Bruker’s FTP servers (ftp.bruker.com and ftp.bruker.de) for file d
loads.

3.6 Exit

Exit terminates NMR-CHECK in an orderly manner. Always close the program w
this function. If you think that NMR-CHECK has crashed because it does not seem
be active anymore – wait. Some of the diagnostic procedures take minutes
completion. Also, most features have a time-out built in. If you still think t
NMR-CHECK has crashed, try to use NMR-CHECK’s Emergency Exit, i.e., double-
click the button in the upper left corner of NMR-CHECK’s main window. If that does
not help, terminate NMR-CHECK on the UNIX level. In such a case, it is strong
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recommended to restart the program immediately and to terminate it with the Exit
function in the File menu. Note: The emergency exit function is deactivated during
e-mail processing.

Figure 3.4 User interface for file transfer



Chapter 4

The Setup Menu

4.1 General

The Setup menu (Figure 4.1) allows for the generation of complete parameter sets
to access remote computers for on-line service and to receive ISDN/modem calls.
In addition, a spreadsheet is available for customer and Bruker service identifica-
tion. Those data are needed for the off-line transmission of diagnosis results. Most
parameters have only to be set once, before the first network connection is opened.

Figure 4.1 The Setup menu
21



22 The Setup Menu

be

ace
cters
DONE

INDEX

INDEX

4.2 Hosts Configuration

Click on Hosts Configuration in order to configure the network parameters of
remote computers. An interface as shown in Figure 4.2 will be opened.

Add:

Creates a new data set. The computer name must consist of one to seven alphanu-
meric characters. It does not need to be identical to the nodename by which the
remote system is known to communications networks. The name, however, must
not be the same as an existing ISDN account (see “ISDN Access Restriction” on
page 25).

There are two pages with parameters: ISDN / Modem (Figure 4.3) and Service
(Figure 4.4). Fill out the ISDN / Modem page when the remote computer has to 
connected over a dial-in line. Ignore this page for Internet connectivity.

• Phone #: Fill in the complete phone number of the ISDN or telephone interf
which the remote computer is connected to. Omit any non-numerical chara
like brackets, parentheses, and dashes.

Figure 4.2 Management of remote computers
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• IP Address: The address of the target system can be easily obtained by ex
ing Setup/General Profile on that computer (Figure 4.7). Please enter the
address in dot notation as shown in Figure 4.3. Leave this field empty for con-
nections to ISDN gateways which assign IP addresses dynamically!

• Access Name: This name is used for ISDN/modem access verification on 
remote computer. Therefore, it has to be included in the access list (Figur)
of the system which receives the call.

Figure 4.3 Setup of ISDN parameters
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• Password: Password of the Access Name as defined on the remote system.

• Speed: Medium means that one B channel is used for the connection, resu
in a maximum transmission speed of 64 kbits/s. This is sufficient for on-
diagnosis and UNIX support. The second B channel can be used for a sim
neous telephone conversation over an ISDN telephone connected to the
ISDN interface.
High means that both B channels are permanently bundled for fastest
transmission. This setting is strongly recommended for XWIN-NMR sharing (see
“Share Xwin-nmr” on page 38).
For modem links, the speed setting is irrelevant. The transfer rate over a
phone link is automatically set to 33600 bits/s in either direction. In orde
achieve the maximum transmission speeds when using external device
baud rate of serial port #1 must be set to a much higher value. This is auto
cally done by NMR-CHECK depending on the device type and the compu
model. (Note: External ISDN terminal adapters cannot be used with Indy w
stations, because the baud rate of their serial ports is limited to 38400 bits

• Sleep if idle?: If set to Yes, the ISDN line will be temporarily closed when n
data transfer occurred during the period of time as set in the line After: .... Sec-
onds. This interval has to be in the range between 30 and 300 seconds. The
nection is automatically re-established (after about 10 seconds) when any
flow to or from the remote sytem appears. This setting is primarily usefu
UNIX support. It has no effect during XWIN-NMR sharing.
For modem links, the sleep mode setting is ignored. It would take about 30
onds to reactivate the line, which is unreasonable.

• After: See above.

• Annotation: Enter an optional, descriptive text of unlimited length here. T
annotation is displayed in brackets after the host name in the Setup/
Hosts Configuration, Connect/Spectrometer, and Multidisplay/Share XWIN-
NMR interfaces.

Fill out the Service page (Figure 4.4) for remote diagnosis, no matter what netwo
type is used. Ignore this page when configuring an ISDN gateway. Customer
the Service page to define the Bruker computer on which the display for XWIN-
NMR sharing has to appear.

• IP Address: See above.

• Password: Enter the password which the remote operator defined at the sta
of NMR-CHECK (see “Create a temporary service account” on page 8). For cus-
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tomers only: (1) Fill in any password you like when this computer can be
directly accessed for XWIN-NMR sharing. (2) Leave this field blank when the
computer is reached via a Bruker ISDN gateway (see ISDN Host below).

• Connect via: Choose the network and device type to be used for the rem
connection. This setting shows up as the default in the Connect/Spectrometer
(Figure 5.2) and Multidisplay/Share XWIN-NMR interfaces (Figure 6.2) and
can still be changed in there. ISDN Card refers to the built-in ISDN interface o
Indy workstations. ISDN/TL must be selected on O2 workstations for establi
ing ISDN links. Modem 33.6/56k is the choice when using the high-spee
modem from Elsa. Modem TL V.34 means that the universal adapt
MicroLink ISDN/TL V.34 should be used in analog mode, i.e., to connect w
a remote modem. Click on Modem Sportster if a high-speed modem from U.S
Robotics is connected to your computer.

• ISDN Host: When setting Connect via to any value but Internet, ISDN Host is
automatically set to the name of the computer which is being configured
remote service or XWIN-NMR sharing). This means that this target computer
directly connected to an ISDN/modem interface. Set ISDN Host to the name of
an already defined ISDN gateway when the target computer is connected t
gateway via Ethernet, i.e. indirectly connected to the ISDN/telephone network

• Annotation: See above.

Modify:

Opens the parameter pages of the selected remote computer. See under Add: for a
description of the parameters.

Delete:

Deletes the entire parameter set of the selected remote computer and remo
computer name from the list.

4.3 ISDN Access Restriction

Click on ISDN Access Restriction in order to define access names and passwo
to be sent by other computers which try to open an ISDN/modem line to 
workstation. An interface as shown in Figure 4.5 will be opened.
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Warning: Your computer accepts incoming ISDN/modem calls when the Activated
part of the access list is empty. Then, the knowledge of any existing login account
and its password is sufficient to open the dial-in line and to log in to the system.
This is a severe security leak. Therefore, you will be immediately requested to add
an entry or warned not to remove the last entry. In other words, always define at
least one entry in this list if your computer is connected to an ISDN/modem inter-
face while the PPP daemon (see “PPP Daemon” on page 29) is running.

Figure 4.4 Setup of service parameters
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Add:

Creates a new ISDN access account, or activates an existing account from the
Deactivated list.

Steps to create a new account:

1. After typing in a non-existing name, an interface as shown in Figure 4.6 pops
up.

2. Type in a password of your choice (four characters or more). Inform the remote
party about the password.

3. Fill in a short description of the remote party into the field Annotation.

4. Click on Save. The new account will be added to the access list.

Modify:

Select a user from the access list and click on Modify in order to change the
account’s password or annotation. The password field will always be empty w
the interface pops up. If you leave that field empty and click on Save, the password

Figure 4.5 Management of ISDN access accounts
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will not be changed (useful if you want to change the annotation only).

Delete:

Select a user from the access list and click on Delete in order to remove that ISDN
access account permanently from the system.

>>:

Select a user from the Activated list and click on >> in order to revoke ISDN
access for that account temporarily. This account can be easily reactivated with the
<< button.

<<:

Select a user from the Deactivated list and click on << in order to re-enable ISDN
access for that account.

Note: ISDN access accounts created with the Add button cannot be used for any
other system access (see “Network security” on page 5). Accounts that have been
tampered with will not be shown in the access list and cannot be used for IS
modem access.

Figure 4.6 Configuration of a new ISDN access account
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4.4 General Profile

Click on General Profile and fill in all data (see Figure 4.7) in order to identify
yourself when sending diagnosis results by e-mail or fax to Bruker. ISDN numbers
can be left blank if you do not have ISDN access. With the Reset button you can
empty all entry fields. Network features like sending diagnosis results and XWIN-
NMR sharing require a valid Service Contract Number. Call your Bruker Service
Center if you do not have one. In addition, the Service Contract Number is dis-
played on the monitor of Bruker’s service computer while a remote spectrom
connection is being established.

The Domain Name and IP Address of the local workstation are listed for informa
tional purposes. If a remote connection to a spectrometer has been opened
ISDN gateway which assigns IP addresses dynamically, the current address 
played on Bruker’s profile form. This temporary address has to be made kno
the customer in order to share XWIN-NMR successfully.

4.5 PPP Daemon

Click on PPP Daemon for managing the PPP daemon. This daemon has to ru
order to make and receive ISDN/modem calls. When the daemon is stopped, the
setup interface will appear as shown in Figure 4.8, i.e., Restart and Stop buttons
are deactivated. Select a Communication Device that corresponds to the telecom
munication hardware available at your computer (for details about the button
ues see “Connect via” on page 25 and “Hardware/software requirements” o
page 4). Then, you have to select the local D-channel protocol to be used by c
ing on the ISDN Protocol Type button. That button becomes deactivated, howev
if one of the dedicated high-speed modems (connected to a conventional tele
interface) is chosen. Ask your telephone company if you are uncertain what p
col type is used. External Device Name, Serial Number, and Firmware Version are
automatically detected everytime the PPP daemon interface is started if a
ported communication device is connected (takes a few seconds). Note: An 
nal ISDN adapter or modem must be connected to serial port #1! 

When the PPP daemon is running, the Start button is deactivated (see Figure 4.9).
Communication Device displays the device type/operation mode for which the P
daemon has been activated. The ISDN Protocol Type button shows the type of pro
tocol that is running if an ISDN device is in use. In other words, the two topm
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buttons reflect the current daemon configuration. You can click on Restart to stop
and start the daemon again. This is often very useful when the activation of a tele-
communication line has failed. Select other device or protocol values and hit the
Restart button if the daemon is misconfigured. The Stop button must be used to
terminate the PPP daemon. This is the software equivalent to unplugging the ISDN
or modem cable. Note that it is impossible to restart or stop the PPP daemon as
long as an ISDN/modem connection is active. For security reasons, the termination
of NMR-CHECK automatically stops the PPP daemon. Additionally, unplug the
ISDN or modem cable if you want to prevent anyone from calling your computer.

Figure 4.7 General profile form
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4.6 Sound

Select a sound level to customize the dialing and error noises. NMR-CHECK always
starts with calm as the default value. Note: On O2 workstations, the lowest possi-
ble, still audible sound level calm is quite loud.

Figure 4.8 Interface to start up the PPP daemon
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Figure 4.9 Interface to restart or terminate a running PPP daemon



Chapter 5

The Connect Menu

5.1 General

The Connect menu (Figure 5.1) is used by Bruker personnel to open network con-
nections to spectrometer workstations. When such a connection has been success-
fully established, the Diagnosis menu becomes active and tests can be performed.
In addition, the UNIX function can be used for support at the operating system
level, and files can be transferred with Upload in the File menu.

You have to initialize your spectrometer with the Connect menu before being able
to run tests locally. In this case, the UNIX function is not needed, and therefore the
button remains deactivated.

Figure 5.1 The Connect menu
33
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5.2 Spectrometer

Click on Spectrometer in order to initialize a diagnosis session either to a remote or
to the local NMR spectrometer. An interface as shown in Figure 5.2 will be
opened.

The list of computer names is similar to the one configured with Setup/Hosts Con-
figuration (cf. Figure 4.2). Hosts which have been set up with a missing service
password (cf. Figure 4.4) will not be listed (this password is essential for a remote
diagnosis session)!

The list entry Local instrument is always present and does not depend on the set-
ups performed with Hosts Configuration. If it is absent, the file /etc/hosts is cor-
rupt.

Figure 5.2 Interface to control network connections
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Connect via: and ISDN Host:

When selecting a remote spectrometer, the default values as defined with Setup/
Hosts Configuration/Service will be set. See “Connect via” on page 25 and “Hard-
ware/software requirements” on page 4 for more details. If a telecommunicatio
link has been already established (via XWIN-NMR sharing or from a remote com
puter), the Connect via button is locked. In that case, NMR-CHECK automatically
detects the parameters of the existing link and uses that line if possible.

Connect:

Opens the network connection to the selected remote spectrometer, or initi
the local instrument. When the connection has been successfully activated, a
box as shown in Figure 5.3 appears at the lower right corner of the screen. T
box can be moved to any place by clicking on it with the left mouse button
dragging the mouse while keeping the button pressed. If the Sleep if idle function
has been set and the inactivity timer has elapsed, the box turns red and “a
becomes “sleeping”. This behavior will be reversed if the connection could b
established.

In the case of a remote connection, a bar graph display will be automat
opened. This is identical to clicking on View/Network Traffic. For details see “Net-
work Traffic” on page 50.

If the connection is running via ISDN/modem, a PPP Status window is launched.
On Indy workstations, an additional ISDN Status window will be generated. The
status display(s) can be opened by clicking on View/On-line Statistics as well. For
details see “On-line Statistics” on page 52.

Note that the acquisition will be automatically locked on the selected spectrom
This is necessary to avoid conflicts between diagnosis procedures and an a
tion on the spectrometer.

Figure 5.3 Connection indicator
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Disconnect:

Closes the current spectrometer connection. If the line is sleeping, NMR-CHECK

tries to reactivate it in order to remove the acquisition lock from the remote
machine.

5.3 UNIX

The menu entry UNIX becomes active when a connection to a remote spectrometer
has been successfully opened. Click on it to get a login window. You will be auto-
matically logged in using the temporary service account. The ability to perform
efficient UNIX support depends on the type of permission which the remote oper-
ator defined at start-up (see “Create a temporary service account” on page 8).

If you are planning to launch XWIN-NMR from the remote login window, you will
not be able to start any acquisition. In order to reactivate acquisition for the re
the on-line session, click on Yes after the question “Do you want to perform acqu
sition on spectrometer ‘...‘?” appears. Keep in mind that this may interfere 
diagnosis procedures.

Any number of login windows can be opened. Close each window with the c
away box (double click on the button in the upper left corner of the wind
frame), by typing exit, or by pressing Ctrl-D when the mouse cursor is in that w
dow.
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The Multidisplay Menu

6.1 General

The Multidisplay menu (Figure 6.1) is used by customers to open a special confer-
ence mode, which is called application sharing. During such a conference, an
application program running on the customer’s computer, like XWIN-NMR, is
shared with a specialist at Bruker. This means that an identical copy of the ap
tion’s display appears on the monitor of the conferee (WYSIWIS – What You
Is What I See). Either party has full access to all functions of the shared prog

Of course, only one user can drive the application at a time. Therefore, some
tional conversation is necessary. This can be done over the phone or via Share
Whiteboard. The person who has been chosen to be passive just release

Figure 6.1 The Multidisplay menu
37
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mouse. Then, he will see two mouse cursors: his own being steady, and an inverted
one from the active person.

The only way for customers to open a telecommunication line to Bruker is to start
an XWIN-NMR sharing session. If that line is used by Bruker to perform diagnosis
procedures, all sharing windows should be iconified to avoid unnecessary data
transfer.

Note that it is impossible to share an application that has been started in the nor-
mal, unshared fashion. Therefore, you cannot share a copy of XWIN-NMR which
has been launched outside NMR-CHECK.

Application sharing is based on the program “XMX 2.1a-pl5”. Portions of t
software are copyright Brown University, Providence, RI, 1991-1996. Brown U
versity makes no representations about the suitability of this software for any
pose. The portions owned by Brown University are provided ‘as is’ with
express or implied warranty from Brown University.

6.2 Share XWIN-NMR

In order to share XWIN-NMR, you have to define the Bruker computer where t
conference partner is located. If this computer is not directly connected to
ISDN, you have to configure the ISDN gateway first (see “Hosts Configurat
on page 22 and “How to set up Nmr-check after installation” on page 11). Not
there must be a workstation at Bruker which is not protected by a firewall, in o
to share XWIN-NMR with Bruker via Internet.

Warning: Assuming that XWIN-NMR sharing is technically possible over the Inte
net, make sure the connection is stable and fast. Otherwise, responses to a
mouse click can take one minute or more to appear at the remote site.

Clicking on Share XWIN-NMR will open an interface as shown in Figure 6.2. Before
you start a sharing session do the following:

1. Start XWIN-NMR outside NMR-CHECK as the same user you started NMR-CHECK.

2. Resize the width of the total XWIN-NMR window to about two thirds of the
screen width.

3. Type setres, set 2D-Mode to “Contour”, set Editor to “xedit”, click on Apply,
and close the interface.
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4. Exit XWIN-NMR.

5. For O2 workstations: Terminate all other applications which make extensive
use of colors, like XWIN-NMR started by other users, Netscape, and so forth.

Select the computer where your Bruker partner is located. The values for Share via
and ISDN Host will be set to the defaults as defined with Setup/Hosts Configura-
tion/Service. See “Connect via” on page 25 and “Hardware/software require
ments” on page 4 for more details. If a telecommunication link has been alrea
established (via Connect/Spectrometer or from a remote computer), the Share via
button is locked. In that case, NMR-CHECK automatically detects the parameters 
the existing link and uses that line if possible. Click on Share. Display tools for
monitoring the transmitted data will be opened (see “Network Traffic” on pag
and “On-line Statistics” on page 52 for details). Next, an empty window pops up 
which XWIN-NMR is automatically started. On O2 workstations, expect a dela
about 10 seconds until the XWIN-NMR interface appears on the screen. This is 

Figure 6.2 Share XWIN-NMR interface
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sharing window where the conference will take place. A window of the same size
and content is launched at the remote computer.

At first sight, the sharing window looks like an ordinary XWIN-NMR interface. You
can identify it easily, however, by its window title (“... Shared XWIN-NMR” at t
local computer, “xmx” on the remote screen). In general, the shared copy of XWIN-
NMR behaves like the normal one. There are a few exceptions:

• The XWIN-NMR display is not resizable.

• New interfaces like search and setres cannot be moved.

• Special processing like phasing, scaling and movement of the displayed
which is performed by pressing a mouse button and dragging the mouse 
keeping the button pressed, behaves differently. Normally, the degree of
cessing action depends on the mouse speed. In sharing mode, the actio
depends on the distance the mouse has been moved. Even when the mo
been stopped, while keeping the button pressed, the processing action c
ues! This makes the mouse more sensitive.
If you want to terminate such a processing action, you must, therefore, re
the mouse button.

• When you share XWIN-NMR 2.5 or newer, the following commands do n
work: BarcodeSxInfo, cfbest, cflims, clbest, config, cpan, gradshim, iconnmr,
masrmon, protocol, smail, temon, uxresources/setres. These commands run
with Tcl/Tk interpreters, which are based on Tk 4.1 or newer. As of release
Tk is incompatible with NMR-CHECK’s sharing software.
When you start one of those functions, it will immediately fail without a m
sage, i.e., nothing happens. However, an associated process xwish2 or xwish3
remains running, which can be terminated with XWIN-NMR’s kill  command.

Commence the XWIN-NMR conference by demonstrating your problem. The
release the mouse and let your Bruker partner take over the activity. He will t
track down the problem, for instance, by inspecting acquisition and proce
parameters, pulse programs, and so forth. If necessary, he will start an acqui
and you can observe its progress on-line. In order to share XWIN-NMR successfully,
obey the following rules:

• Use ISDN in high-speed mode.

• Be patient! During an XWIN-NMR conference, large amounts of data have to
transferred over the line. Every little motion of the mouse in the 1D disp
window causes a screen refresh. Therefore, do not unnecessarily move
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mouse across the sharing window. Note that your local sharing copy of XWIN-
NMR reacts nearly as fast as usual, but the remote copy is delayed by the ISDN
transfer speed.

• Do not click several buttons too quickly after each other. Wait until the com
tion of a complex action has been confirmed over the phone or on the s
whiteboard by the remote person, before you execute another function. 
watch the “Thruput” column in the middle of the ISDN Status window (Indy
workstation): The remote screen has been updated when the throughpu
down to zero. When using an O2 computer, keep an eye on the col
“Obytes” and “Ibytes” of the “ppp0” line shown by the PPP Status display at
the local and remote host, respectively.

• Avoid “special processing” as described above, where a short mouse move
causes a flood of data.

• Never close additional windows, like the ones created with setres, search, or
xwinplot, by using their exit function! This may terminate the entire shar
session. Type kill instead and click on the application to be terminated.

• Turn off the sharing of mouse movements by clicking on Telepointer (see
below) if the conference is held via a conventional modem link.

If the convenient way of switching the input activity by just moving the mo
becomes a problem, the input permission of one conferee can be tempo
revoked. This can be achieved by enlarging the sharing window to the righ
interface as shown in Figure 6.3 appears.

Figure 6.3 Interface for configuring the sharing permissions
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The two icons symbolize the conferees, identified by the name of the computer
they use (abbreviated to the first three letters). Select the conference partner and
click on View. The icon will loose its hat and hammer. As a result, that person can-
not drive XWIN-NMR anymore. Nevertheless, he can still see what the conference
partner is performing in the sharing window. The active conferee can reactivate the
passive one by clicking on Floor. Seat also deactivates the selected person, but it
only removes the icon’s hammer. This is different from the View mode in that the
passive conferee can click on his icon, which then rises an arm. With this, h
signal his partner that he wishes to become active again.

If one conferee is in View mode, the performance can be improved by clicking 
Telepointer. As a result, movements of the mouse cursor will no longer be 
played in the sharing window of the conference partner. This eliminates und
able screen refreshes. This is especially useful when sharing XWIN-NMR over a
high-speed modem line. It is not recommended to click on Telepointer if both con-
ferees are in Floor mode. This can easily lead to the false and confusing con
sion that a currently active partner is idle.

The other buttons of the interface in Figure 6.3 do not perform any useful function
Therefore, do not use them.

Terminate an XWIN-NMR sharing session with the menu entry Stop Sharing (see
below). Typing exit in XWIN-NMR will certainly terminate XWIN-NMR, but the
(empty) sharing window will remain running.

6.3 Share Whiteboard

The Share Whiteboard button becomes active when an XWIN-NMR sharing session
has been successfully opened (see previous section). Click on it to share a 
board (notepad) with your Bruker partner. An extra sharing window as show
Figure 6.4 will pop up. This window is independent of the XWIN-NMR sharing win-
dow.

The whiteboard is intended for written conversation. Perform the following ste

1. Click on Size in the bottom line with the right mouse button until “Font size 20”
is displayed in the status line above.

2. Click on T in the tool box.
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3. Click on the notepad and enter text. Terminate each line by pressing Enter. Do
not move the mouse before you press Enter, because the text you just typed in
may be cleared by a screen refresh.

Characters of the current line can be deleted by hitting the Backspace key. The cur-
sor keys have no effect. In order to delete a line, click on skull and crossbones in
the tool box, move the mouse cursor over that line, and click on it with the left
mouse button.

Figure 6.4 Shared whiteboard
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Be careful when creating drawings, because they might congest the data line.

Terminate the shared whiteboard with the menu entry Stop Sharing (see below).

6.4 Restore Colors

If running XWIN-NMR on O2 workstations under IRIX 6.3, the data display is
blacked out when the mouse cursor enters a certain class of applications (e.g.,
View/Network Traffic or /usr/sbin/clock). This effect is cancelled when the mouse
cursor travels back into the XWIN-NMR window. During XWIN-NMR sharing, the
other parts of XWIN-NMR’s display might change colors as well. This happens
particular if another “color-consuming” program (e.g., Netscape or XWIN-NMR

started by a different user) is running at the same time. Click on Restore Colors in
order to refresh the sharing display.

Hint: Stop all applications but NMR-CHECK prior to establishing XWIN-NMR shar-
ing. Then, Restore Colors should not be needed.

6.5 Stop Sharing

Stop Sharing closes all sharing windows on either computer, and it terminates
conference. If the XWIN-NMR sharing window is closed while there is still signif
cant data throughput on the line, the termination signal cannot reach the re
computer. This leaves a frozen sharing window on the remote screen, which c
easily removed with the click-away button.

Stop Sharing also terminates the ISDN/modem connection if it is not used by 
other on-line activity of NMR-CHECK.



Chapter 7

The Diagnosis Menu

7.1 General

The Diagnosis menu (Figure 7.1) is used to check the major hardware components
of remote spectrometers or of the local instrument. The menu entries become
active after a spectrometer connection has been successfully opened with the Con-
nect/Spectrometer interface (see “Spectrometer” on page 34).

Figure 7.1 The Diagnosis menu
45
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Click on one of the component names to open a new interface, specialized for that
part of the instrument. The interfaces for CCU, ACB, HPPR, BSMS, and RX22 pop
up immediately. The ones for TCU, FCU, RCU, and GCU will be created after a
delay of about 15 seconds.

7.2 Handling of the diagnosis interfaces

The structure of all diagnosis interfaces is similar. Figure 7.2 shows the BSMS
interface as an example. 

Test functions:

The box in the upper left part contains the available diagnosis procedures. Just
click on the function names or the preceding check boxes for selection. You can
combine any number of tests.

Figure 7.2 Typical diagnosis interface
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Launch Tool:

Launch Tool opens an extra interface, which requires special knowledge. It is
intended for Bruker service personnel, in order to access rarely used test proce-
dures and special hardware parameters. The best way of terminating the extra
interface is to click on the same button as before, which is now labeled Stop Tool.
After closing the diagnosis interface, the complete output is still accessible with
View/Tools Log (see “Test Results/Tools Log” on page 50).

Open Console:

In the case of the CCU interface, Open Console replaces the Launch Tool button.
Click on it to open a new window in which communication between the work
tion and the CCU can be performed. This requires a special cable (deliver
Bruker; part number for Indy workstation: HZ04161; part number for O2 work
tion: HZ10034) to be connected between the serial port #2 of the workstation and
the Console Port of the CCU board. Keep this cable connected all the time.

If the CCU is running, i.e., it was successfully booted, a CCU UNIX prom
appears in the console window. Otherwise, nothing will be displayed. Also,
will not get any error message from within this interface, because it is design
monitor the basic output of the CCU board, no matter what it is. If the console
dow remains empty after pressing the red restart button of the board, c
whether the cable is properly connected.

The best way of terminating the console window is to click on the same butto
before, which is now labeled Close Console. After closing the diagnosis interface
the complete output is still accessible with View/Tools Log (see “Test Results/
Tools Log” on page 50).

Select All/None:

Simply selects all or no diagnosis function(s).

Mode Standard/Expert:

Switches between two diagnosis pages. Standard offers general and often use
tests, Expert shows more specialized functions.

Listing of test results:

Every test prints its approximate duration immediately after start-up. Note tha
running time may vary if errors occur. Subsequently, the test results will be lis
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The kind and amount of output strongly depends on the performed test function.
Finally, the name of the test and the time of its completion are listed. You always
have to wait until this final line appears before being able to perform another
action.

Start:

Starts the selected diagnosis procedures. During tests which run about two minutes
and longer, a progress bar is shown in the lower right corner of the listing area.
This bar visualizes the degree of completion. Be patient – firmware download
take up to 25 minutes per board!

Halt:

If more than one test has been selected, Halt will terminate the sequence after th
current test is over. You cannot interrupt a running test.

Reset:

Reset clears the listing area and deselects all test functions. The test results a
viewable with View/Test Results (see “Test Results/Tools Log” on page 50).

Cancel:

Cancel closes the interface. As long as the current spectrometer conne
remains open, the current listing of test results will be redisplayed when the 
diagnosis interface is opened again.



at list
Chapter 8

The View Menu

8.1 General

The View menu (Figure 8.1) gives access to diagnosis results recorded in the past,
it lists the current and past activity of the ISDN/modem interface, and shows gen-
eral system parameters relevant for NMR experiments.

Listings are always shown in the display area of NMR-CHECK’s main window. If
some related action takes place while a particular listing is on the screen, th

Figure 8.1 The View menu
49
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will not change automatically. You have to update the listing by clicking on the
same function again. The on-line tools Network Traffic and On-line Statistics,
however, are permanently updated. Clicking on these two functions has no effect
when the corresponding window is fully visible. Otherwise, the tool display will
be de-iconified or unobscured.

8.2 Test Results/Tools Log

Test Results allows you to review the entire output from diagnosis procedures that
were started with this copy of NMR-CHECK. A submenu shows the past eight days
during which test results have been produced. Click on the day you are interested
in. Then, the complete listing of that day can be browsed. A header shows the cre-
ation date of each listing, which is identical to the time when the first test was
started, and gives the identification of the local workstation. Each test result is pre-
ceded by a heading that shows the spectrometer on which the diagnosis procedure
was performed. The local instrument is represented by the system name as stored
in the file /etc/sys_id.

Tools Log does the same as Test Results but handles the logged output of Launch
Tool and Open Console (see “Handling of the diagnosis interfaces” on page 46).

8.3 Network Traffic

Clicking on Network Traffic opens a bar graph display as shown in Figure 8.2. The
number of bars can vary between two and four.

Figure 8.2 Network Traffic display
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The bars labeled “NetTCP Act” and “NetIF [ec0]” are always present. “Ne
[ec1]” or “NetIF [ec2]” is shown when the O2 or Indy workstation, respective
contains a second Ethernet controller, which is always the case on comp
directly connected to and driving the NMR spectrometer. “NetIF [ppp0]” is d
played while a dial-up connection (via ISDN adapter or modem) is open.

The upper number at the end of each bar represents the value at full deflec
Therefore, each tick mark equals to a tenth of this value. This scaling is auto
cally recalibrated, for each bar independently, when the data throughput ch
significantly. The red value in the middle is the maximum deflection. If this pea
value has not been exceeded during the past ten seconds, it will be reset to t
rent value (peak-hold function). The lower number represents the average, calc
lated over a period of three seconds.

NetTCPAct measures the total data throughput for the Transmission Control 
tocol (TCP) in kilobytes per second. NetIF [...] denotes the Network InterFac
given in brackets. ec0 is the name of the Ethernet port usually connected to a L
Area Network (LAN). The console computer CCU is normally connected to
Ethernet port ec1 (O2 workstation) or ec2 (Indy workstation). The ISDN port of
the built-in card (Indy) and serial port #1 (connected to an ISDN adapte
modem) is called ppp0 when in use. All interface traffic is measured in packets per
second. Note that the packet size is variable and limited to about 1500 byt
Ethernet and ISDN/telephone network.

8.4 Dial-up Connections

With Dial-up Connections you can list all ISDN and modem calls that came in
went out. Normally, two periods are available; one usually starts on the pre
Sunday, the other one covers the week before. Outgoing calls are identified b
remote host name. Incoming calls show the ISDN access name (see “Se
ISDN parameters” on page 23), which was transmitted by the remote system. T
activation and deactivation of the telecommunication line as well as the durat
accurately listed. On Indy workstations, links which use the built-in ISDN in
face are listed with a separate entry for each B channel. Mixed up entries and
tions result from connection failures, where the switching order of B chan
becomes unpredictable. Successful channel bundling (high-speed mode) 
software-detectable if an external ISDN adapter is used and, therefore, no d
tion is made in the Dial-up Connections listing. High-speed ISDN links can be
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identified by an orange “DCD” LED, however. That LED turns green for mediu
speed links (one B channel).

8.5 On-line Statistics

Clicking on On-line Statistics opens a status display as shown in Figure 8.3. Two
“ppp0” lines appear if an attempt was made to open a telecommunication link
ISDN or telephone network) since the last reboot of the workstation. An asterisk
(*) behind “ppp0” indicates that the ISDN/modem interface is currently not in use.
Watch the colums “Ibytes” and “Obytes” of the lower ppp0 line, as they mon
the number of incoming and outgoing bytes per second at the ISDN/modem 
face, respectively. If an external ISDN adapter or modem is used, some info
tion about the data flow can be also obtained from the LED’s “TxD” (transmit
i.e., outgoing data) and “RxD” (received data). The upper ppp0 line is not auto
ically updated on computers running under IRIX 5.3. If you are interested in
current content of that line, double-press the key N while the mouse is inside the
PPP status window, or close the status display and open it again. On Indy wo

tions, an additional display pops up (see Figure 8.4). Each B channel of the built-in
ISDN interface is monitored separately. The upper part shows the data throu
for outgoing and incoming traffic. All values are updated every second whe
ISDN connection is open. Most important are the “Thruput” columns. They s

Figure 8.3 PPP status display
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the effective transmission rate in kilobits per second, averaged over intervals of
five seconds. Note that the values can exceed the theoretical limit of 64 due to
compression.

The lower part of the interface displays the connection status. Watch the “R
column. “64” means that the corresponding B channel is currently active, no 
ter what the throughput is. “0” indicates an unused channel. “Phone Number
plays the dialed number for outgoing Euro ISDN calls only. When the interface is
closed and restarted while the line is still open, the telephone number wi
longer be displayed. The phone number of incoming calls is never recognized
“Status” column may show arbitrary information. Therefore, always watch the
umn “Rate”. The ISDN status tool was written by Silicon Graphics. For that 
son, we do not have any influence on those malfunctions.

The PPP and ISDN status displays can be closed by double clicking on the b
in the upper left window corner, or by pressing q while the mouse is in the statu
display.

Figure 8.4 ISDN status display
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8.6 System Configuration

Click on System Configuration to get a listing of important configuration parame-
ters of the local system. This includes general properties of the workstation as well
as NMR-related characteristics.

8.7 Logo/Intro/Nothing

Logo displays the start-up logo. It will vanish if you click on it. Intro shows NMR-
CHECK’s greeting. Nothing clears the listing area.
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NMR-CHECK Comment Form

Name / Institution / Company: 
.....................................................................................................................................................

.....................................................................................................................................................
Address:
.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................
Phone /Fax /E-mail:
.....................................................................................................................................................
Spectrometer / Computer:
.....................................................................................................................................................
Operating System / NMR-CHECK Version:
.....................................................................................................................................................
Comments / Error report / Suggestions (continue on extra sheet if required):
.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................

(Please mail to software support group. The address is printed on the second manual page.)
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